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Preface

The purpose of this guide is to help you install Operations Analytics Predictive
Insights.

After completing all steps documented in this guide, you will have a set of
running Operations Analytics Predictive Insights components ready to configure
into a fully functional system.

Audience
The audience for this manual is the network administrator or operations specialist
responsible for installing Operations Analytics Predictive Insights.

To install Operations Analytics Predictive Insights successfully, a basic knowledge
of the following is required:
v Administration of the Linux operating system.
v Administration of IBM InfoSphere Streams.
v Administration of the DB2 database management system.
v Administration of OMNIbus and OMNIbus WebGUI.
v Operations Analytics Predictive Insights

Components
IBM® Operations Analytics Predictive Insights consists of four main components.

The IBM Operations Analytics Predictive Insights components are:
v The Database component: is used to store configuration data, metadata and

metric data.
v The Analytic component: performs data mediation and processes incoming data

to discover any anomalies that are present.
v The UI component: presents any discovered anomalies through the IBM

Dashboard Application Services Hub application or the IBM Tivoli Integrated
Portal application.

v The Mediation Tool: is used to configure a data source and the data model that
Operations Analytics Predictive Insights will monitor.

Operations Analytics Predictive Insights documentation includes the following
guides:
v Release notes
v Installation Guide
v Upgrade Guide
v Administration Guide
v Error Messages Guide

© Copyright IBM Corp. 2011, 2016 v



vi IBM Operations Analytics Predictive Insights: Upgrade Guide



Chapter 1. Before you begin

Read this information to find the prerequisites for upgrading to Operations
Analytics Predictive Insights 1.3.5 and the steps involved.

Prerequisites

Before you can upgrade to Operations Analytics Predictive Insights 1.3.5, your
existing Operations Analytics Predictive Insights environment must be at version
1.3.3 fix pack 3.

Summary of steps

Table 1. Summary of upgrade steps

Step

Mandatory,
Recommended or
Optional Notes®

Upgrading the
prerequisite
software

Mandatory You must upgrade Jazz™ for Service Management and configure it to
use TLSv1.2, upgrade OMNIbus ObjectServer, and upgrade OMNIbus
WebGUI before you upgrade Operations Analytics Predictive Insights.

Upgrading
Operations
Analytics
Predictive Insights

Mandatory If possible, use Installation Manager GUI to upgrade Operations
Analytics Predictive Insights. Use console-mode only if a GUI-based
upgrade is not possible..

Upgrading the
Mediation Tool on
Windows

Optional Only required if your Mediation tool is running on Microsoft Windows.

Migrating
customized rules
files

Optional You need to complete this step if you customized the probe rules files in
the previous installation. In version 1.3.3, the probe rules file was
installed in: $PI_HOME/probe/omnibus/probes/linux2x86/stdin-
tasp.rules

Starting the
Operations
Analytics
Predictive Insights
analytics
component

Mandatory You must start Operations Analytics Predictive Insights after the
upgrade completes.

Upgrading your
visualization
application to
Dashboard
Application
Services Hub

Optional If you did not use Dashboard Application Services Hub for visualization
on your 1.3.3, system, you can upgrade to Dashboard Application
Services Hub.

© Copyright IBM Corp. 2011, 2016 1
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Chapter 2. Upgrading the prerequisite software

Before you upgrade Operations Analytics Predictive Insights to version 1.3.5, you
must upgrade Jazz for Service Management, OMNIbus ObjectServer, and
OMNIbus WebGUI.

You must complete the upgrade of the prerequisite software in the following order:
1. Upgrade Jazz for Service Management and configure Jazz for Service

Management to use TLSv1.2.
2. Upgrade OMNIbus ObjectServer.
3. Upgrade OMNIbus WebGUI.

Upgrading Jazz for Service Management
You must upgrade Jazz for Service Management to version 1.1.2.1 before you
upgrade to Operations Analytics Predictive Insights 1.3.5.

Procedure
1. Download and extract the following files:
v JAZZ_FOR_SM_1.1.2.1_FOR_LNX.zip

v IBM_WAS_FOR_JSM_FOR_LNX_ML.zip

Extract both files to a directory on the server on which you plan to install Jazz
for Service Management.

2. Complete the following steps to run the prerequisite scanner.
a. Navigate to the directory in which you extracted the Jazz for Service

Management zip file.
b. To start launchpad, enter the following command:

./launchpad.sh

c. Click Tools > IBM Prerequisite Scanner > Run

d. Resolve any failures in the following sections:
v DSH - Dashboard Application Services Hub in JazzSM
v ODP - Common prerequisites in JazzSM

Note: You can ignore failures in other sections of the scanner output. For
example:
network.availablePorts.db2instance FAIL PortsInUse:631,6001,60001,5901,523... 50000
os.servicesTCPavailablePorts.db2instance FAIL PortsInUse:50000 50000
DBType FAIL DB2 DB2ShdNotBeInstalled

If you run the prerequisite scanner as a non-root user, you can ignore the
following failure:
user.isAdmin FAIL False True

3. Complete the following steps to install Jazz for Service Management.
a. Change to the /eclipse subdirectory of the Installation Manager installation

directory and use the following command to start Installation Manager.
./IBMIM
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To record the installation steps in a response file for use with silent
installations on other computers, use the -record response_file option. For
example:
./IBMIM -record install_1.xml

b. From the main menu, click File > Preferences.
c. Click Add Repository. Click Browse and go to the ...JazzSM/

JazzSMRepository/disk1/diskTag.inf repository. Repeat to add the
...JazzSM/WAS/WASRepository/disk1/diskTag.inf repository.

d. Click OK.
e. Click Upgrade.
f. Complete the Installation. When prompted to choose a program to start,

select None.

Note: The Jazz for Service Management installer creates the profile so you
do not need to create a profile when prompted to do so at the end of the
installation.

4. Complete the following steps to configure Jazz for Service Management to
support TLS 1.2.
a. To log in to Dashboard Application Services Hub, type the following URL:

https://<host>:<port>/ibm/console/logon.jsp

where <host> is the host name of the Dashboard Application Services Hub
server and <port> is the port number. The default port number is 16311.

b. Click Console Settings > WebSphere Administrative Console.
c. Click Launch WebSphere Administrative Console.
d. Click Security > SSL certificate and key management > SSL

configurations > NodeDefaultSSLSettings > Quality of protection (QoP)
settings

e. In the Protocol field, select TLSv1.2.
f. Click Apply.
g. Click Save.
h. Edit the <JAZZ_PROFILE_HOME>/properties/ssl.client.props file, where

JAZZ_PROFILE_HOME is /opt/IBM/JazzSM/profile by default.
i. Update the value of the com.ibm.ssl.protocol field to TLSv1.2. For example:
com.ibm.ssl.protocol=TLSv1.2

5. To stop Jazz for Service Management enter the following command:
<JAZZ_PROFILE_HOME>/bin/stopServer.sh server1

where <JAZZ_PROFILE_HOME> is /opt/IBM/JazzSM/profile by default.
When prompted, enter the profile username and password.

6. To start Jazz for Service Management enter the following command:
<JAZZ_PROFILE_HOME>/bin/startServer.sh server1
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Upgrading the OMNIbus ObjectServer
You must upgrade the OMNIbus ObjectServer to version 8.1.0.5 before you
upgrade to Operations Analytics Predictive Insights 1.3.5.

Before you begin
1. Download and install the OMNIbus prerequisite scanner to make sure you

have all the OMNIbus requirements in place before you begin the installation.
The prerequisite scanner can be downloaded from Tivoli Netcool/OMNIbus
Knowledge Center section IBM Prerequisite Scanner.

2. Run the prerequisite scanner to discover if there are any missing items that
must be installed.

3. Install all packages which are marked as missing.

About this task

OMNIbus ObjectServer can be installed either by root or by a non-root user. If you
choose to install as a non-root user, ensure the appropriate permissions on the
install software and target location are given to the chosen non-root user. If you
install as root, the ongoing management of OMNIbus must be done as root.

Note: If OMNIbus and the Operations Analytics Predictive Insights Analytics
component are on the same server and owned by the same user, do not set the
NCHOME variable. This is in line with the Tivoli Netcool/OMNIbus Knowledge
Center section Setting Tivoli Netcool/OMNIbus environment variables (UNIX and
Linux). The NCHOME environment variable specifies the home location for Tivoli
Netcool/OMNIbus. Setting NCHOME may cause the probe to point to the wrong
location and not run.

Procedure
1. Copy the OMNIbus ObjectServer installation software, OMNIbus-v8.1.0.5-

Core.linux64.zip , to an empty directory.
2. Extract the zip file:

unzip OMNIbus-v8.1.0.5-Core.linux64.zip

Note: The package filename is correct for .
3. Change to the /eclipse subdirectory of the Installation Manager installation

directory and use the following command to start Installation Manager.
./IBMIM

To record the installation steps in a response file for use with silent installations
on other computers, use the -record response_file option. For example:
./IBMIM -record install_1.xml

4. From the main menu, click File > Preferences.
5. Click Add Repository. Click Browse and go to the ...OmnibusCore/

OMNIbusRepository/repository.config repository.
6. Click OK.
7. Click Upgrade

8. Follow the installation wizard to complete the upgrade, selecting the default
options.

Note: When prompted, to choose which program to start, select None.
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What to do next
1. After you have completed the upgrade, use the following command to test if

all prerequisites are met for the OMNIbus ObjectServer:
ldd /opt/IBM/tivoli/netcool/omnibus/platform/linux2x86/bin*/nco* | grep "not found"

2. To ensure that the ldd command resolves all dependent libraries, set the
LD_LIBRARY_PATH both in the current shell and in ~/.bashrc.
The following is an example of how this might be done:
export LD_LIBRARY_PATH=/usr/lib64:/lib64:/opt/IBM/tivoli/netcool/omnibus/platform/linux2x86/lib64:
/opt/IBM/tivoli/netcool/platform/linux2x86/lib64:/usr/lib:/lib:
/opt/IBM/tivoli/netcool/omnibus/platform/linux2x86/lib:
/opt/IBM/tivoli/netcool/platform/linux2x86/lib:$LD_LIBRARY_PATH

3. Install any prerequisites that are identified as missing.

Upgrading OMNIbus WebGUI
You must upgrade OMNIbus WebGUI to version 8.1.0.4 before you upgrade to
Operations Analytics Predictive Insights 1.3.5.

Before you begin

You must install IBM WebSphere SDK Java Technology Edition Version 7.0 before
you upgrade OMNIbus WebGUI. For more information, see Installing IBM
WebSphere SDK Java Technology Edition Version 7.0 in the WebSphere Application
Server Knowledge Center.

About this task

You must use the same user that you used to install and upgrade Jazz for Service
Management. OMNIbus WebGUI can be installed by root or a non-root user.
Ensure the appropriate permissions on the installation software and target location
are given to the non-root user if you want to install as non-root.

Procedure
1. Ensure that both Jazz for Service Management and the OMNIbus ObjectServer

are running.
2. Copy the OMNIbus WebGUI installation software, OMNIbus-v8.1.0.4-

WebGUI.linux64.zip, to an empty directory.
3. Extract the zip file:

unzip OMNIbus-v8.1.0.4-WebGUI.linux64.zip

4. Change to the /eclipse subdirectory of the Installation Manager installation
directory and use the following command to start Installation Manager
./IBMIM

To record the installation steps in a response file for use with silent installations
on other computers, use the -record response_file option. For example:
./IBMIM -record install_1.xml

5. From the main menu, click File > Preferences.
6. Click Add Repository. Click Browse and go to the ...WebGUI/

OMNIbusWebGUIRepository/repository.config repository.
7. Click OK.
8. Click Upgrade.
9. Follow the installation wizard to complete the upgrade. Select the default

options and record any users and passwords that you enter.
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Chapter 3. Upgrading Operations Analytics Predictive Insights

Instructions on how to upgrade Operations Analytics Predictive Insights from
version 1.3.3 to version 1.3.5.

The upgrade process for Operations Analytics Predictive Insights covers the
upgrade of all installed Operations Analytics Predictive Insights components. If
you wish to make any topology change, you must do so as a separate installation
task after you complete the upgrade.

If you installed Operations Analytics Predictive Insights components on multiple
servers, you must perform the upgrade on each individual server. You can perform
the upgrade in graphical mode, using the IBM Installation Manager, or in console
mode.

For information on the Operations Analytics Predictive Insights version 1.3.5
requirements, see the Operations Analytics Predictive Insights Installation Guide.

Upgrade order for a distributed installation
If the Operations Analytics Predictive Insights components are distributed on
multiple servers, you must upgrade components in a particular order depending
on how the components are distributed.

Note: When you select the database component for upgrade, the upgrade process
updates the version number for the database component in the installation
manager record but does not upgrade the database component itself. The upgrade
of the database component is done automatically when you upgrade the Analytics
component.
v If the Database and UI components were installed on the same server by the

same user and, therefore, managed by the same Installation Manager instance,
complete the upgrade in the following order:
– Analytics component
– UI component

In this configuration, the version number for the Database component is
automatically updated in the installation manager record when you upgrade the
UI component.

v For all other distributed installations, upgrade the components in the following
order:
– Database component
– Analytics component
– UI component
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Upgrading using GUI mode
Upgrading Operations Analytics Predictive Insights using the GUI mode.

Before you begin
1. Create a directory for the upgrade software. For example:

mkdir ~/PredictiveInsights_1.3.5

2. Download and extract the Operations Analytics Predictive Insights package
from the media to the new directory.

3. On each server that has the Analytics component running, log in as the
analytics user, for example, scadmin, and stop the Analytics instance:
$PI_HOME/bin/stop.sh

4. Stop any instance of the Mediation Tool that is running.
5. If Operations Analytics Predictive Insights version 1.3.3 was configured to use

LDAP authentication, you must replace the LDAP authentication with the
authentication method that was in place when you installed Operations
Analytics Predictive Insights 1.3.3.
For example, if you used the ncoadmin user from an ObjectServer user
repository to install version 1.3.3 and later replaced the ObjectServer user
repository with an LDAP user repository, then you must switch to
authenticating against an ObjectServer user repository before you start the
upgrade.
To switch from LDAP to ObjectServer authentication, complete the following
steps:
a. Make a backup copy of the following configuration files:
v <installdir>/UI/wlp/usr/servers/piserver/ldapRegistry.xml

v <installdir>/UI/wlp/usr/servers/piserver/server.xml

v <installdir>/UI/wlp/usr/servers/piserver/taspConfig.xml

where <installdir> is /opt/IBM/scanalytics by default.
b. To remove the LDAP integration and configure the UI server to use the

ObjectServer user repository, restore the <installdir>/UI/wlp/usr/servers/
piserver/server.xml that you backed up in step 5 of the Configuring the
LDAP User Registry procedure.

c. To configure the WebGUI to point to the ObjectServer, enter the following
commands:
cd <WEBGUI_HOME>/configtool/linux.gtk.x86_64
./ncwConfigUI -WASUserID smadmin -WASPassword smadmin

where <WEBGUI_HOME> is /opt/IBM/netcool/omnibus_webgui by default

About this task

You must complete the upgrade procedure on each server on which an Operations
Analytics Predictive Insights component is installed. To upgrade each component,
you must use the user account that was initially used to install that component. If
multiple components were installed by different user accounts on the same server,
ensure that you switch accounts before you upgrade individual components.

Note: If the Operations Analytics Predictive Insights Analytics and UI components
were installed by different users on the same server or on different servers, you
must upgrade the Analytics component before you upgrade the UI component.
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Procedure
1. As the user that was used to install the component or components you are

upgrading, change to the predictiveInsightsInstaller1.3.5 directory in the
directory in which you extracted the upgrade software.

2. To start the installer, run the following command:
./install.sh

3. Select the Update option and click Next.
4. Select all of the components present on the server for upgrade. The Update

Packages screen displays all Operations Analytics Predictive Insights
components that are installed on the server.

5. If the displayed version is the version to which you want to upgrade, click
Next.

6. Accept the terms of the license agreement and click Next.
7. For each component, enter the required parameters and click Validate. After

the values you enter are validated, click Next.
8. Click Update.

During the upgrade, changes are made to your Operations Analytics
Predictive Insights Database, Analytics component, Mediation tool, and UI.
The validation ran in step 7 ensures that your Operations Analytics Predictive
Insights system is in a good state before the upgrade.

Note: Any component that is running is stopped during the upgrade.
9. Click Finish when the update completes.

10. If Operations Analytics Predictive Insights version 1.3.3 was configured to use
LDAP authentication, complete the following steps to set up LDAP
authentication for version 1.3.5.
a. Copy the files that you backed up in step 5 of the Before you begin section

to their original location.
b. To grant users in the LDAP directory access to Operations Analytics

Predictive Insights User Interface, do the following:
1) Change to the <Liberty_Install_Home>/UI/bin directory. The default

path for <Liberty_Install_Home> is /opt/IBM/scanalytics.
2) Enter the following command

./addAccess.sh <user | group> <LDAP user or group name>

For example, to grant access to an LDAP group called operators, enter
the following command:
./addAccess.sh group operators

Note: After the upgrade completes, you must clear the web browser cache
before you log in to your visualization tool.

What to do next

On the Analytics server, the upgrade procedure does not remove older JAR files
when it installs later versions of the files. To resolve these file conflicts, complete
the following steps:
1. Enter the following commands to remove the older JAR files:

rm -f $PI_HOME/lib/commons-lang3-3.1.jar
rm -f $PI_HOME/lib/commons-math3-3.0.jar
rm -f $PI_HOME/lib/org.eclipse.emf.common_2.8.0.v20130125-0546.jar
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rm -f $PI_HOME/lib/org.eclipse.emf.common.ui_2.7.0.v20130125-0826.jar
rm -f $PI_HOME/lib/org.eclipse.emf.ecore_2.8.3.v20130125-0546.jar
rm -f $PI_HOME/lib/org.eclipse.emf.ecore.xmi_2.8.1.v20130125-0546.jar

2. To compile each topic, enter the following commands:
cd $PI_HOME/spl/instances/Analytics<topic>
./compile.sh

Where <topic> is the name of the topic.

Upgrading using console mode
Upgrading Operations Analytics Predictive Insights using console mode.

Before you begin
1. Create a directory for the upgrade software, for example:

mkdir ~/PredictiveInsights_1.3.5

2. Download and extract the Operations Analytics Predictive Insights package
from the media to the new directory.

3. On each server that runs the Analytics component, log in as the analytics user,
for example, scadmin, and stop the Analytics instance.
$PI_HOME/bin/stop.sh

4. Stop any instance of the Mediation Tool that is running.
5. If Operations Analytics Predictive Insights version 1.3.3 was configured to use

LDAP authentication, you must replace the LDAP authentication with the
authentication method that was in place when you installed Operations
Analytics Predictive Insights 1.3.3.
For example, if you used the ncoadmin user from an ObjectServer user
repository to install version 1.3.3 and later replaced the ObjectServer user
repository with an LDAP user repository, then you must switch to
authenticating against an ObjectServer user repository before you start the
upgrade.
To switch from LDAP to ObjectServer authentication, complete the following
steps:
a. Make a backup copy of the following configuration files:
v <installdir>/UI/wlp/usr/servers/piserver/ldapRegistry.xml

v <installdir>/UI/wlp/usr/servers/piserver/server.xml

v <installdir>/UI/wlp/usr/servers/piserver/taspConfig.xml

where <installdir> is /opt/IBM/scanalytics by default.
b. To remove the LDAP integration and configure the UI server to use the

ObjectServer user repository, restore the <installdir>/UI/wlp/usr/servers/
piserver/server.xml that you backed up in step 5 of the Configuring the
LDAP User Registry procedure.

c. To configure the WebGUI to point to the ObjectServer, enter the following
commands:
cd <WEBGUI_HOME>/configtool/linux.gtk.x86_64
./ncwConfigUI -WASUserID smadmin -WASPassword smadmin

where <WEBGUI_HOME> is /opt/IBM/netcool/omnibus_webgui by default

About this task

You must upgrade each Operations Analytics Predictive Insights component on the
server on which the component is installed. Therefore, if Operations Analytics
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Predictive Insights components are installed on multiple servers, you must run the
upgrade on each server.

Procedure
1. As the user that was used to install the component or components you are

upgrading, change to the predictiveInsightsInstaller1.3.5 directory within
the directory in which you extracted the upgrade software.

2. To start the installer, enter the following command:
./install.sh -c

3. Enter 2 to Update - Find and install updates and fixes to installed software
packages.

4. Enter 1 to select the Operations Analytics Predictive Insights package. All of
the Operations Analytics Predictive Insights components present on the server
are selected for upgrade.

5. Enter N to continue. The installer prepares and validates the set of updates.
6. Enter A to accept the license agreement.
7. Enter N to continue.
8. Enter the requested parameters for each component.
9. Enter N to continue.

10. Enter U to update.
11. Enter F to finish.
12. Enter X to exit.
13. If Operations Analytics Predictive Insights version 1.3.3 was configured to use

LDAP authentication, complete the following steps to set up LDAP
authentication for version 1.3.5.
a. Copy the files that you backed up in step 5 of the Before you begin section

to their original location.
b. To grant users in the LDAP directory access to Operations Analytics

Predictive Insights User Interface, do the following:
1) Change to the <Liberty_Install_Home>/UI/bin directory. The default

path for <Liberty_Install_Home> is /opt/IBM/scanalytics.
2) Enter the following command

./addAccess.sh <user | group> <LDAP user or group name>

For example, to grant access to an LDAP group called operators, enter
the following command:
./addAccess.sh group operators

Note: After the upgrade completes, you must clear the web browser cache
before you log in to your visualization tool.

What to do next

On the Analytics server, the upgrade procedure does not remove older JAR files
when it installs later versions of the files. To resolve these file conflicts, complete
the following steps:
1. Enter the following commands to remove the older version of the JAR files:

rm -f $PI_HOME/lib/commons-lang3-3.1.jar
rm -f $PI_HOME/lib/commons-math3-3.0.jar
rm -f $PI_HOME/lib/org.eclipse.emf.common_2.8.0.v20130125-0546.jar
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rm -f $PI_HOME/lib/org.eclipse.emf.common.ui_2.7.0.v20130125-0826.jar
rm -f $PI_HOME/lib/org.eclipse.emf.ecore_2.8.3.v20130125-0546.jar
rm -f $PI_HOME/lib/org.eclipse.emf.ecore.xmi_2.8.1.v20130125-0546.jar

2. To compile each topic, enter the following commands:
cd $PI_HOME/spl/instances/Analytics<topic>
./compile.sh

Where <topic> is the name of the topic.

Upgrading the Mediation tool on Windows
Instructions on how to upgrade the Operations Analytics Predictive Insights
Mediation tool on Windows.

About this task

If you installed the Mediation tool on windows, you upgrade the Mediation tool
by executing a fresh install of the tool.

Procedure

Instructions on how to upgrade the Mediation tool on Windows.
1. Log on to the Windows environment to which you want to install the

Mediation tool.
2. Extract the Operations Analytics Predictive Insights package from the media.
3. Open the windowsMediationTool folder within the extracted package. This

folder contains the file PredictiveInsights-MediationTooling-1.3.5-win32.zip.
4. Extract the ZIP file to your desired installation location.
5. Open the folder to which you extracted the ZIP file, and in turn open the

contained eclipse folder.
6. Double click on the eclipse.exe icon. When you open the tool, you will be

asked to choose a workspace. Choose a directory unique to the Mediation tool.
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Chapter 4. Updating the OMNIbus probe rules file

The OMNIbus probe rules file defines how the OMNIbus probe processes event
data to create alerts. You must migrate any customizations in the 1.3.3 probe rules
file to the version 1.3.5 file. You can also add customizations for new features in
version 1.3.5

Migrating customizations from a previous version of the probe rules
file

Instructions on how to migrate updated rules files.

About this task

If you customized the stdin-tasp.rules file for the previous version of Operations
Analytics Predictive Insights, you must manually re-insert these changes into the
version 1.3.5 stdin-tasp.rules file. The version 1.3.5 stdin-tasp.rules file is
located in the $PI_HOME/probe/omnibus/probes/linux2x86/ directory.

Procedure
1. Navigate to the directory containing the back up of the pre-upgrade

stdin-tasp.rules file.
This file can be found at: <installer_home>/installer/TASPBAK/<version
number>_<backup_timestamp>/probe/omnibus/probes/linux2x86/stdin-
tasp.rules

Where
<installer_home> is /opt/IBM/scanalytics/install_scadmin if version 1.3.3
was installed to the default installation path.
<version number> is the version number of the previous version of Operations
Analytics Predictive Insights that was installed.

2. Copy the customizations you made to the pre-upgrade stdin-tasp.rules file
and insert them into the $PI_HOME/probe/omnibus/probes/linux2x86/stdin-
tasp.rules file.

Example

The following is example code from a customized stdin-tasp.rules file.
# Compute alarm severity depending on whether the potentially anomalous KPI(s)
# contain a service-impacting KPI.
# You will need to update this statement to reflect your Predictive Insights implementation.
if (int($TASPCorrelationId) >= 0) {

if (regmatch($TASPAnomalousMetrics, "Service_Impacting_KPI_1")
|| regmatch($TASPAnomalousMetrics, "Service_Impacting_KPI_2")

) {
@Severity = 4

} else {
@Severity = 3

}
} else if (int($TASPCorrelationId) == -1) {

# Consolidated alarms - many problems in one alarm.
@Severity = 4

} else if (int($TASPCorrelationId) == -2) {
# Data Availability alarms

© Copyright IBM Corp. 2011, 2016 13



@Severity = 5
} else if (int($TASPCorrelationId) == -3) {

# Information Events should have a lower severity.
@Severity = 2

} else if (int($TASPCorrelationId) == -4) {
# System health alarms are very important.
@Severity = 5

}

# Map the data source severity directly, if it exists.
# (Note: resolution events should be set to severity 1, the generic clear will

set them to 0 later)
update(@Severity)

Adding new customizations to the probe rules file
You must customize the probe rules file to forward attribute names and values,
that are mediated with the data, to the Active Event List.

Procedure
1. Log in as the administrative user, typically scadmin.
2. Open the probe rules file which is located in the $PI_HOME/probe/omnibus/

probes/linux2x86/stdin-tasp.rules file.
3. Insert the following text at the end of the file:

if(exists($TASPAttributeNames)) {
@TASPAttributeNames = $TASPAttributeNames
update(@TASPAttributeNames)

}

if(exists($TASPAttributeValues)) {
@TASPAttributeValues = $TASPAttributeValues
update(@TASPAttributeValues)

}
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Chapter 5. Starting the Operations Analytics Predictive
Insights analytics component

Use the start.sh script to start the Operations Analytics Predictive Insights
Analytics component.

Procedure
1. Change to the $PI_HOME/bin directory.
2. As the administrative user, typically scadmin, enter the following command to

start the Analytics component:
./start.sh [-t=<topic_name>]

The command starts the Operations Analytics Predictive Insights processing
framework and any topic you specify. If you omit the -t parameter, the
command starts all topics on the server.

3. To start extracting data from the data source, enter the following command:
$PI_HOME/bin/admin.sh run_extractor_instance -t=<topic> -l=<latency>

For more information, see run_extractor_instance.
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Chapter 6. (Optional)Upgrading your visualization application
to Dashboard Application Services Hub

Operations Analytics Predictive Insights version 1.3.5 supports Tivoli Integrated
Portal and Dashboard Application Services Hub as visualization applications for
the UI.

About this task

Operations Analytics Predictive Insights version 1.3.5 supports both Dashboard
Application Services Hub and Tivoli Integrated Portal for visualization purposes.
Moving your visualization from Tivoli Integrated Portal to Dashboard Application
Services Hub is an optional step.

If you are considering moving from Tivoli Integrated Portal to Dashboard
Application Services Hub, it is recommended that you first get your Dashboard
Application Services Hub system up and running before you decommission your
Tivoli Integrated Portal environment.

There are two routes you can take to migrate from Tivoli Integrated Portal to
Dashboard Application Services Hub. Pick one of the following scenarios:

Procedure
v Scenario 1: Install Dashboard Application Services Hub on a separate server,

which allows you to run both Tivoli Integrated Portal and Dashboard
Application Services Hub in parallel.
Pursue this procedure if you want to first confirm that your Dashboard
Application Services Hub functions as expected and you are ready to
decommission the existing Tivoli Integrated Portal visualization component.
1. Complete the installation of Operations Analytics Predictive Insights so that

you have a working 1.3.5 system.
2. Install on a separate server as per the installation instructions within the

Installing Jazz for Service Management section of the Installing documentation.
3. Install the fix pack.
4. Install WebGUI on the same server as Jazz for Service Management. For

more information on how to install WebGUI, see the section Installing
OMNIbus WebGUI in the "Installing" documentation.

5. Install the Operations Analytics Predictive Insights version 1.3.5 UI
component on the same server as Jazz for Service Management, configuring
it to work with the new Dashboard Application Services Hub. This process is
described in the Installing the UI component section of the "Installing"
documentation.

6. When you are ready to decommission the existing Tivoli Integrated Portal
visualization component, uninstall the following:
– Operations Analytics Predictive Insights UI component, that is configured

to work with Tivoli Integrated Portal
– OMNIbus WebGUI 7.4
– Tivoli Integrated Portal 2.2
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v Scenario 2: Install Dashboard Application Services Hub to the server on which
you currently run Tivoli Integrated Portal.
Complete this procedure if know you want to move to Dashboard Application
Services Hub, and the new Dashboard Application Services Hub must exist on
the server which currently hosts Tivoli Integrated Portal.
1. Stop Tivoli Integrated Portal. For more information on how to stop Tivoli

Integrated Portal, see the Stopping Tivoli Integrated Portal section of the
"Administering" documentation.

2. Install on the Tivoli Integrated Portal server. To install Jazz for Service
Management, you should use a different user other than that which was
used to install Operations Analytics Predictive Insights as per the installation
instructions within the Installing Jazz for Service Management section of the
"Installing" documentation.

3. Install the fix pack.
4. Uninstall Operations Analytics Predictive Insights version 1.3.3 and install

version 1.3.5. When you are installing the UI component, configuring it to
work with the new Dashboard Application Services Hub.

What to do next

Follow the post install configuration steps in the Initial configuration of Operations
Analytics Predictive Insights section of the Administering documentation to complete
the set up of Dashboard Application Services Hub. In particular, ensure that you:
v Add the Operations Analytics Predictive Insights launch scripts for the Active

Event List.
v Update your system so that your Dashboard Application Services Hub is

prepared for an unplanned shut down
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Chapter 7. Rolling back an upgrade

Installation Manager can roll back the upgrade that it performed. The roll back
reverts your Operations Analytics Predictive Insights system from version 1.3.5 to
version 1.3.3.

Before you begin

Before you roll back the upgrade, do the following
v Stop Operations Analytics Predictive Insights: $PI_HOME/bin/stop.sh.
v Stop any instance of the Mediation Tool that is running.
v Complete the following steps to change Jazz for Service Management SSL

configuration from TLSv1.2 to SSL_TLS.
1. To log in to Dashboard Application Services Hub, type the following URL:

https://<host>:<port>/ibm/console/logon.jsp

where <host> is the host name of the Dashboard Application Services Hub
server and <port> is the port number. The default port number is 16311.

2. Click Console Settings > WebSphere Administrative Console.
3. Click Launch WebSphere Administrative Console.
4. Click Security > SSL certificate and key management > SSL

configurations > NodeDefaultSSLSettings > Quality of protection (QoP)
settings.

5. In the Protocol field, select SSL_TLS.
6. Click Apply.
7. Click Save.
8. Edit the <JAZZ_PROFILE_HOME>/properties/ssl.client.props file, where

JAZZ_PROFILE_HOME is /opt/IBM/JazzSM/profile by default.
9. Update the value of the com.ibm.ssl.protocol field to SSL_TLS.

For example:
com.ibm.ssl.protocol=SSL_TLS

10. To stop Jazz for Service Management enter the following command:
<JAZZ_PROFILE_HOME>/bin/stopServer.sh server1

where <JAZZ_PROFILE_HOME> is /opt/IBM/JazzSM/profile by default.
When prompted, enter the profile username and password.

11. To start Jazz for Service Management enter the following command:
<JAZZ_PROFILE_HOME>/bin/startServer.sh server1

Procedure
1. Change to the Installation Manager installation directory.
2. Use the following command to start the Installation Manager wizard:

./IBMIM

3. In the main Installation Manager window, click Roll Back.
4. Follow the installation wizard instructions to complete the roll back.
5. The rollback does not delete the Service Diagnosis Dashboard and any custom

dashboards you created. To delete the dashboards:

© Copyright IBM Corp. 2011, 2016 19



a. In Dashboard Application Services Hub, click the Console Settings icon, ,
in the menu bar.

b. Under General, click Pages.
c. Expand the Incident page.
d. Click the check box beside the Service Diagnosis Dashboard.
e. Click Delete and click OK to confirm.
f. If you created custom dashboards, expand the page under which you

created the dashboards. If you did not change the default location, custom
dashboards are created under the Default page.

g. Click the check box beside each custom dashboard.
h. Click Delete and click OK to confirm.

6. If you created one or more topics after you upgraded to version 1.3.5, enter the
following command to delete each topic:
$PI_HOME/bin/admin.sh delete_topic <topic name>

For example:
$PI_HOME/bin/admin.sh delete_topic network

You must recreate this topic in version 1.3.3, deploy a model to the topic and
start data extraction. For more information, see Configuring mediation and
Analyzing data in the Configuration and Administration Guide.

7. If you upgraded the Mediation Tool on Windows, uninstall and reinstall the
Mediation Tool provided in version 1.3.3.

What to do next

If you customized the OMNIbus probe rules file, stdin-tasp.rules, after the
upgrade, copy the 1.3.3 version of the file from <installer_home>/installer/
TASPBAK/1.3.3.0_<backup_timestamp>/probe/omnibus/probes/linux2x86/stdin-
tasp.rules to $PI_HOME/probe/omnibus/probes/linux2x86/stdin-tasp.rules.

<installer_home> is /opt/IBM/scanalytics/install_scadmin if version 1.3.3 was
installed to the default installation path.

<backup_timestamp> is the timestamp for the time the backup was created.
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Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM‘s application programming interfaces.
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If you are viewing this information in softcopy form, the photographs and color
illustrations might not be displayed.
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Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, Acrobat, PostScript and all Adobe-based trademarks are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
other countries, or both.

Cell Broadband Engine and Cell/B.E. are trademarks of Sony Computer
Entertainment, Inc., in the United States, other countries, or both and is used under
license therefrom.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries,
or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, and service names may be trademarks or service marks
of others.

For trademark attribution, visit the IBM Terms of Use Web site
(http://www.ibm.com/legal/us/).
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